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Communication Generation 

 
Part II – Defining and Assigning Communications 

 
This is the second of two documents detailing the procedures to create communications with PeopleSoft.  The 
two documents look at Communications Generation (or CommGen) through these areas:   
 

• Part I – Managing Communications (BI Publisher Setup and Communication Setup) 
• Part II – Defining and Assigning Communications (Comm Data Source, Template, Report Definition, 

Event Definition, Communication Generation) 
 

Introduction 
 
This document covers the Communication Data Source, 3C Events and Communication Generation. 
 
Communication Data Source - Outline 

• The Communication Data Source page is based on the Admin Function and displays the Delivered 
Fields associated with the Function. 

• The Communication Data Source is the XML File that is the main source of the Communication 
Template (created in Word and defined in Report Definition).   

• To provide more fields, a Data Source Query is created.  It describes the “what” or “from what 
additional data fields” the process should extract data to merge to the communication.   

•  With all Admin Functions, one or more queries may be added to gain any additional fields.  Except for 
the GEN Function, this is the method to supply Core Record Variable Fields.  (Information regarding 
the GEN Admin Function can be found further on in this document.) 

o When the Data Source page is populated, an XML File is created that serves as the primary 
source for the Communication (Word) Template. 

o The elements involved in defining the Data Source are: 
 Custom Extract Data Source Query or Queries 
 Communication Data Source (XML File) 
 Microsoft Word Template 
 Report Definition and Template (BI Publisher) 
 Letter Code associated with the Report Definition 

 
 
3C Engine Events and the 3C Engine – Outline 

• Some characteristics of the 3C Engine: 
o Delivered process that eliminates need to manually batch assign checklist, communications 

and comments.  
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o A query-based process to determine the population to whom you will be sending your 
Communication – a “Pop Select Query.” 

o Note:  The Pop Select Query is an altogether separate query from the other query which is also 
described in this document - the “Data Source Query.”    

o The Pop Select (or PS) Query is used to assign new communication records to individuals. 
o The Administrative Function’s Bind Record MUST be used. 

• The 3C Engine is a rules-based PeopleSoft application engine that you can integrate with functional 
transactions to automatically insert or update communications, comments, and checklists records. 

o The 3C Engine can thus reduce the amount of manual intervention (or customizations) needed 
to automate the use of 3Cs throughout the system. 

o The 3C Engine assigns rules known as 3C Engine Events, typically communications in the form 
of letters or emails. 
 The 3C Engine Event can be any of the 3Cs to either a person or an organization.  

• An example of a 3C Engine Event is adding a collections letter to a student’s 
communication. 

 Use Administrative Functions and detail data to define the 3C Engine Events to 
identify sets of communication, checklists, and comments for the 3C Engine to assign.   

• To set up the 3C Engine: 
o You create a 3C Engine Event that tells the system what to process (that is, which 

Communications, Checklists, and Comments to assign).   
o Then Security is set using 3C Groups, just as security is set for Communications (as well as 

Checklists and Comments). 
o 3C Groups are used to group access to 3C Events and define security.   

 A 3C Event will not be applied if the user is not in the 3C Event Group.  This limits who 
can cause 3C Events. 

 
Communication Generation - Outline 

• The Communication Generation process is a procedure that enables you to select specific fields from 
which to extract critical data for a Letter Code assigned to the IDs - individual or organization - for 
whom you want to generate the communication. 

o The Communication Generation process supports Usages (names, address, and salutation), 
enclosures, joint communications, communication recipients, checklist extract and status 
update, print communication comment, and so on.    

o To use the Communication Generation process, you must first assign a communication 
record for the desired Letter Code to the intended recipients.   
 You can assign communications to individuals or organizations manually, or  
 You can use the 3C Engine to assign them using the Population Selection process. 
 You can also use the Population Selection process from within the Communication 

Generation process to select the IDs to which you want to send the communication.   
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o NOTE these requirements.  The IDs selected are processed only if they have a Communication 
assigned to them which is:   
 Using the specified Letter Code,  
 Within the Communication Date Range, and  
 Is not yet completed.   

 
 
 
 

CONTENTS 
11. Create Custom Extract Data Source Query to define from what additional fields the process should 

extract data [Communication Data Source Query or Custom Extract Data Query ] 
12. Create a Communication Data Source (XML File) [Communication Data Source page] 
13. Create a Microsoft Word Template  
14. Create a Report Definition [Associate the Communication Data Source with the target Template] 
15. Create or Adjust the Letter Code [Associate the Report Definition with the Letter Code] 
16. Create a Population Selection Query to define who should receive the communication [Pop Select] 
17. Create Event Definition – Event ID - Define 3C Engine Events [Event Definition page] 
18. Assign 3C Group(s) to the Event Definition [Event 3C Groups page.  Assign Security] 
19. 3C Engine Run Control – Run 3C Engine 
20. Communication Generation Run Control 
21. Person Communication – Communication Outcome - View Generated Communication 
22. Assign a Communication to an Individual 

 
 
 

11. Create Custom Extract Data Query (Communication Data Source Query)  
• If you don’t need any additional merge data fields to include in your communication other than what 

the delivered generic data extract contains, then you are ready to create your Data Source and 
proceed to Report Definition. 

• Once the letter data is defined, in order to get variable data required for the communication, you 
create a Data Source Query.  Such a query needs a bind variable entered as a Prompt.    

• NOTE:  If you use the GEN Administrative Function, you will not be using any Variable Data 
Fields in the Data Source Query.   However, all the other rules discussed below with regard to 
Admin Functions still apply. 

• Create one or more custom queries; the query will contain Variable Data Fields from the 
Administrative Function’s related Core Record.   

• NOTE:  The GEN Admin Function does not have a Core Record.   
• Two warnings from PeopleBooks: 

• You must include at least query prompts that retrieve person ID or organization ID or a 
combination of the two. 
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• You must list each prompt that you create as criteria in the Criteria page of the Query Manager 
component. 

• The Data Source Queries will be added to the Communication Data Source page under Custom 
Extract Data.   

• In order to test the validity of the query output, once the query is created, create a test version, 
excluding the prompts for variable data. 

• The PeopleTools Query tool (Navigation: Reporting Tools > Query > Query Manager) is used to create 
most Communication Data Sources.  

• When naming the Data Source Query, keep in mind that you can use the same query for different 
Letter Codes, so do not limit the name by the Letter Code.  If appropriate, you may want to enter 
either the Context or Category as the last part of the name.  In general, name it as follows. 
 

 
Naming Convention for Custom Data Source Queries (30 characters) 
• Letter “W” 
• Two letter code for the office 
• Underscore 
• Two letters “DS” for Data Source 
• Underscore 
• Name describing content of query 
• Example:  WSF_DS_NET_ACCT_BAL 

 
• NOTE:  The Data Source Query defines the “what,” or “from what additional data fields” the process 

should extract data to merge to the communication.  
• This query should not define “who” should receive the communication.  
• That information can be acquired through a Pop Select query described later.   

• When using Query in conjunction with RTF template-based files, design the Data Source structure to 
be as close as possible to the actual document template structure to improve runtime performance. 

• Important:  Create Prompts in the query: 
• The Data Source Query must be based on the Administrative Function used in the 

Communication Data Source setup. 
• About Prompts:  Minimally, the query must include one query prompt to retrieve a Person ID 

or Organization ID, or a combination of the two. 
1. The query must be prompted on fields that can be populated using the Administrative 

Function key fields, and no others. 
2. You don’t have to prompt on every key field 
3. The prompts should return the specified fields for just one ID. 

• Don’t build conditional logic into your custom Data Source queries.  Otherwise you’ll get very 
strange results in your communications.  Build good Pop Select queries instead (later). 

• Avoid using Expressions as part of a field or criteria, as the process may abend abnormally.  
(Note:  This warning is from the March 2010 Oracle White Paper—Campus Solutions 9.0 
Communication Generation) 

• IMPORTANT NOTE about Prompts in the Data Source Query 
1. Based on the Data Source Context selected for the Communication Data Source, the 

Query prompt(s) will be validated when the Register Data Source button is clicked. 
2. Validation of any given Data Source Context will be based on the following:  
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3. Unique Prompt Name – Person ID and Organization ID:  Validate the 
Person/Organization Context - Person ID and Organization ID fields: 

a. On the Edit Prompt Properties page, change the Unique Prompt Name.  BIND 
1 is replaced as Unique Prompt Name value 

b. Change Person ID fields (e.g. EMPLID), from BIND1 to PERSON_ID 
c. Change Organization ID fields (EXT_ORG_ID), from BIND1 to COMMON_ID 

 
Original Prompt Properties – EMPLID Edited Prompt Properties – EMPLID 

  
 

4. Variable Data Fields:  Validate the Administrative Function Context - Variable Data 
Fields (found in Administrative Function Core Records) 

a. On the Edit Prompt Properties page, change the Unique Prompt Name from 
“BIND1” to the actual name of the field (e.g., ACAD_CAREER, STRM).   

b. Below is an example showing how to change the Prompt Properties for the 
Variable Data Field of ACCOUNT_TERM (which is associated with the 
Administrative Function Code of SFAC): 
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Original Prompt Properties – Variable Data Field Edited Prompt Properties – Variable Data Field 

  

5.  
6. Keep in mind that with the GEN Admin Function, there will be no Variable Data Fields 

involved. 
7. Edit Type:  In each instance, for the Edit Type, select No Table Edit. 
8. Prompt Table:  Be sure that Prompt Table is blank. 

• NOTE:  Without a prompt called PERSON_ID or ORG_ID, the query will not be available to a 
Communication Data Source. 

• Save and name the query.  The query name to be used with the next step is 
WSF_DS_NET_ACCT_BAL.    

1. This query is based on only one table (record or view):  WSF_NET_ACT_BAL.   
2. There is only one Prompt:  PERSON_ID as the Unique Prompt Name, replacing  

 

12. Create a Communication Data Source (XML File)  
• The Data Source is an XML file produced by PeopleSoft that contains all the data fields you want to 

merge into your letter.  At this point in the process the XML file will only contain the field names with 
sample data. 

• Open this page to add or update a Communication Data Source – Navigation:  Campus Community> 
Communications> Set Up Communications> Communication Data Source   

• Note:  A stock set of standard communication data (name, address, etc.) is included by default.  Any 
additional information you want to add can be included using PeopleSoft Query.   

• You can have multiple simple queries to retrieve additional information, i.e. only pull data 
related to a single topic. 

• The Data Source Map ID links the XML Data Source to the Communication Generation process 
information.   

• Using the Register Data Source button on the bottom of the page automatically stores the Data 
Source inside the appropriate PeopleTools tables.   
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• IMPORTANT NOTE:  The Communication Data Source is different from Data Source under BI 
Publisher.  For the Communication Generation process to succeed, the Communication Data Source 
must be created from the Communication Data Source page within Campus Community, not from 
within Reporting Tools > BI Publisher. 

• OPENING AN EXISTING DATA SOURCE:   In most instances the Communication Data Source will 
already exist.    

• To search for an existing Data Source, in the Data Source Map ID box, type in the name, if 
known.   

• If the Data Source Map ID not known, you can search the entire list or you can type in part of 
the name, i.e., the Admin Function, using “contains” or a wild card (%).  For example, to search 
for a result containing the Admin Function named SFAC, you could type “SFAC” as follows, and 
any current Data Source Map IDs containing that name will be listed: 

 

 
 

• Select the Data Source Map ID.   
• When you open the page, most fields associated with the Data Source Map ID (in this 

example:  WSF_GENERAL_DATA_SOURCE – note that this does not follow the naming 
conventions discussed below) will be filled in, including the fields in the sections Data Source 
Context and Generic Process Data, similar to the following: 
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• The Data Source Context section provides the Administrative Function name.  The 
appropriate boxes, Person and/or Organization are checked. 

•  The Generic Process Data section lists the generic data that the Communication Generation 
process must always extract to accommodate all of the Campus Solutions communication 
features.   

1. The data varies depending on whether the context is for a person, an organization, or 
both.   

2. Each of the features is associated with the names of the records into which the 
extracted data will be placed for the BI Publisher templates.  

3. You can prioritize the order of the records using sequencing, but you cannot add or 
delete any of them. 

4. Under the Critical Data column to the right, you can check the boxes to indicate which 
are considered critical.  Later, when generating letters, you can indicate not to 
generate if Critical Data is missing. 

5. Since letters and emails have different critical data, set up two CDS’s for each 
administrative function.  The setup must indicate what data is considered critical. To 
send an email, it is critical that the prospect, applicant, or student has an email 
address; a postal address is critical data for a letter. 

• CREATING A NEW DATA SOURCE:   If a new Data Source is required, these are the instructions. 
• After assuring yourself that the required Data Source Map ID does not currently exist, click on 

Add a New Value. 
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• Type in the name using the Naming Conventions shown here for the Data Source Map ID 
(Communication Data Source).   

• NOTE:  There may be IDs for other offices, but not the one you are seeking.  This circumstance 
will require a new ID to be created. 

 
 

 
Naming Convention for Communication Data Source 
• 30 characters 
• Letter “W” 
• Two-letter code for the office 
• Underscore, then the three- or four-character name of the 

Administrative Function (exception is “GENERAL” instead of “GEN”) 
• Underscore, then “DATA_SOURCE” 
• Underscore, then either “LETTER” or “EMAIL”  

 
• The following page will open with only the first box (Data Source Map ID) filled in (with the 

new name you created).   In this example, the name is WSF_GENERAL_DATA_SOURCE_LETTER.  
 

 
 

• Add a meaningful description in the Description box. 
• The Owner ID is optional.  If you choose to use it, select the appropriate item from the Owner 

ID dropdown box, such as Student Financials or Student Records. 
• Data Source Type will read XML Doc Object. 
• The Active box will be checked.  Do not change. 
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• Under Data Source Context, *Administrative Function, click on the magnifying glass and select 
the appropriate item.   

1. The Administrative Function drives the fields that are included by default (Generic 
Process Data). 

2. Once you have selected the Administrative Function, the section headed Generic 
Process Data will be populated with information related to that Function. 

• The Person and/or Organization boxes are checked depending upon the Administrative 
Function selected.   

1. Note that when both boxes are checked, there are 12 rows under Generic Process 
Data.   

2. When just the Person box is checked, there are nine rows. 
3. And when just the Organization box is checked, there are five rows.  
4. You can select or deselect either one of them.  In this example, the Organization box is 

unchecked. 
• The Communication Data Source page will now be similar to this: 
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• Critical Data:  As mentioned above, under the Critical Data column to the right, you can check 

the boxes to indicate which are considered critical to the creation of the output for individual 
or organization recipients.   

1. At a later step in the process, on the Communication Generation page, administrative 
users can specify what to do if Critical Data are missing: 

a. Either to process the communication without the data, or 
b. Not to process the communication for IDs that are missing the data. 

2. Note that Checklist Items, Enclosures, and Person Communication Recipients cannot 
be marked as Critical Data. 
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• Custom Extract Data:  Add Custom Extract Data, i.e. the Data Source Query 

•  Whether updating an existing ID or creating a new one, using the Query Name Search/Lookup 
drop down box, include one or more custom Data Source Queries to include additional data to 
your communications as described above. 

• When using the Search/Lookup for the Query Name, logic evaluates the settings in the Data 
Source Context section (which comes from the Administrative Function) based on: 
 

1. Whether Person and/or the Organization is associated with the Function. 
 

 
2. In addition, the system evaluates which queries contain the Record that contains the 

Variable Data fields from the Administrative Function indicated on the page, and 
restricts the return of those queries. 

3. The Max Nbr, or maximum number, is specific to queries only.  The number can be 
used to restrict the number of rows selected.  In general, leave the field blank or you 
can set it to 99.  See below for more information. 

• As discussed above, if a query is used, you MUST include prompts for the fields needed for the 
record that is being joined via the Communication record, including the Variable Data.  For 
instance, you will always be passing Emplid.   

a. NOTE:  As alluded to above, the Unique Prompt Name field in the Data Source 
Query must be the name of the Variable Data field, e.g. EMPLID becomes 
PERSON_ID.   
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• NOTE:  A bind record is not needed here.  That will be discussed later in relation to Pop Select 
Queries. 

• Register the Data Source:   Once the Custom Extract Data query has been added, click on the Register 
Data Source button at the bottom of the page.   

• The system evaluates each query when you register the Communication Data Source and 
registers only the queries that it validates can be successfully executed by the Communication 
Generation process.   

• The system compares the setup of the query prompts with the information in the Data Source 
Context of the Communication Data Source, i.e. the Administrative Function and the 
Person/and or Organizations.   

• NOTE:  If the expected query does not appear as a choice, review the elements of the Data 
Source Query to be sure that it meets all the needed conditions as enumerated above. 

• When you Register the Data Source, the button text will be grayed out, and the audit 
information fields (i.e. Registered Date/Time, etc.) will be populated by the system. 

• The bottom of the page will now resemble this: 
 

 
 

• View and Download the Sample XML Data File   
1. Next, in order to view and download the XML file, click on the View/Download Sample 

Data File link.  The entire XML file will display.   
2. The output from the Data Source Query is appended at the end of the generated 

sample data and is ready for use in a BI Publisher template.   
3. The beginning of the XML file will resemble this: 

 

Register the Data 
Source  

Custom Extract Query or 
Queries 

 

  
  

View and Download XML 
File 
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4. The end of the XML file will resemble this: 
 

 
 

• Save the XML file by right-clicking on the file and selecting “Save Page As.”  Save it to a 
location that you can access when creating your Word template. 

1. The XML file will be needed to load into the Word template using the delivered Design 
Helper tool during a later step.   

2. The file contains all the fields that the Communication Generation process will extract, 
which can be included as variables in a Word template. 

• IMPORTANT NOTE about reregistering:  When a change is made to the Communication Data 
Source, including any update to the query (or queries) or application class, the system re-
activates the Register Data Source button.   

1. The button must be clicked again to re-register the Data Source. 
2. The Data Source must be registered again for the system to accept and use the 

changes. 
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3. Note that after you have clicked on the button, the Last Update information is 
refreshed. 

• Communication Data Source page with multiple queries:  The following is an example of a 
different Communication Data Source page that has three data source queries associated with 
it under Custom Extract Data.  The fields in this section are populated as follows:  

1. *Type:  Query. 
2. Query Name:  Three queries that were selected from the dropdown. 
3. Max Nbr:  The maximum rows of data for the query to extract for one emplid.   

a. NOTE:  To extract all the possible values for an ID, leave the Max Nbr field 
blank or set to 99. For example, if your query includes the ACAD_CAREER field 
and an ID has an application for 5 different academic careers, when the field is 
blank the query will extract 5 of the values. If you want to extract only 2 values, 
set the maximum number to 2.  
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13. Create a Template in Microsoft Word  
• BI Publisher Design Helper:  In order to create a template in Microsoft Word, you will need to 

download and install BI Publisher Design Helper.   If you have a version of Microsoft Word later than 
2010, there are specific instructions to follow to install the product.  See document XXXXXXXX for 
details.  

• BI Publisher is the product you will use to add XML coding to your Word template for letters, 
emails, labels, and envelopes.  

• Follow instructions within PeopleSoft:  Main Menu> Reporting Tools> XML Publisher> Setup> 
Design Helper.   

1. Or download - http://www.oracle.com/technetwork/middleware/bi-
publisher/downloads/index.html 

• You may also need to download Java Runtime Environment (JRE) if it is not already installed on 
your system – 

1. See below under POSSIBLE PROBLEM WITH FIRST TEMPLATE CREATION 
2. And look at http://java.com/en/download/index.jsp 

• Creating a Template in Word:  These instructions are for creating a template in Word from scratch.   
• However, it is likely that you have existing letters that you will want to utilize.  In that case, 

adapt these directions as needed.   
• NOTE:  If you have a letter that already has data fields, do not overwrite those fields; rather, 

copy the text into a new letter.   

• BI Publisher is a standalone Java-based reporting technology that provides users with the 
ability to design and create document templates with common desktop applications such as 
Microsoft Word (and Adobe Acrobat).  Below are general instructions on the creation of 
templates using Microsoft Word. 

• The BI Publisher Word Plug-in, or Template Builder, is a wizard extension of Microsoft Word 
that simplifies the creation of RTF templates. 

• Template Builder demos and samples, which are loaded during the installation of Template 
Builder can be found in the following location on a user’s hard drive:   

1. C:\Program Files\Oracle\BI Publisher\BI Publisher Desktop\demos 
2. C:\Program Files\Oracle\BI Publisher\BI Publisher Desktop\samples\RTF templates 

• Once the Sample Data (XML file) has been saved, open Word (Tip:  Put in a few blank lines at 
the top of the page). 

• Select Add-Ins from the menu.  The screen will appear as follows with the choices applicable to 
Add-Ins: 
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• Load the sample XML data by navigating to Data > Load XML Data. 

 
• A window will open.  Navigate to the XML file you saved (in this example, 

WSF_GENERAL_DATA_SOURCE). 

• When the following message appears, indicating the data was successfully loaded, click OK. 

 
• After entering the text of the communication, move the cursor to where you want the first variable 

field placed.   
• Add the variable fields by clicking on Insert > Field. 

 

 
• The list of fields appears: 
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• Default fields begin with “Fld” such as “Fld Emplid,” “Fld First Name” and “Fld Emailid.” 
• If you cannot locate the field, use the Find box at the top.  When you have the field selected, click on 

the Insert button.  
 

 
 

•  Continue in the same manner until all the fields have been entered.  
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• Conditions:  Conditions on fields can be set for field.   (NOTE:  There are other documents in the SFIS 
Blog illustrations of using conditions.) 

• Formatting:  Review the Oracle White Paper for details on these items: 
• Dates can be formatted in Template Builder.   
• Word can create an executable hyperlink using a Hyperlink field. 
• Inserting images.   

• Recurring data fields, for example, a list of items for a student, can be added using Insert > Table 
Wizard. 

• Tables can also be inserted for non-recurring data using the Wizard. 
• Validate the template using Tools > Validate Template.   

• When the message “No Error found” appears, click the Close button. 
 

 
 

• POSSIBLE PROBLEM WITH FIRST TEMPLATE CREATION:  Java and Error No: 53:  The first time 
you create a template you may receive the following error message when you validate the 
template.  If so, you will need to upgrade your version of Java as shown below.  Once you do 
so, you should not receive the message again. 
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• Navigate to Tools > Options > Preview and observe the contents of the field Java Home. 
 

 
 
• If it reads C:\Program Files\Java\jre6 change it to C:\Program Files\Java\jre7 
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• Click OK. 
 

• Validate the template using Tools > Validate Template.  You should see the message “No Error 
found.” 

• Save the template as Rich Text Format (RTF).   If you do not, you will see the following message.   

 
• To review the overall formatting of the letter and the placement of the variable fields, click on 

Preview.  Select RTF. 
 

 
 

• The variable fields will resemble this: 
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• When the letter is completed, click OK and save the template as RTF.   For this example, the template 
letter was named S4E_Pre_Collect_StudentLeft.rtf.  The name is derived from the Letter Code and an 
abbreviated description.  Note that the last part of the template name (Pre_Collect_StudentLeft) is an 
abridged version of the Long Description of the Comm Key.   Below is a suggested naming convention: 
 

 
Naming Conventions for the Word Template file 
• First three fields:  The Letter Code 
• Underscore, then the name of the Report Definition. 
• Example:  S4E_Pre_Collect_StudentLeft.rtf 
 

 

14. Create or Update a Report Definition – The Report Definition is the area where you associate 
the Communication Data Source with the Word template.  It is one of the elements in BI Publisher. 
• Access the Report Definition page.  Navigation:  Main Menu > Reporting Tools > BI Publisher > Report 

Definition.   
• To update an existing Report Definition, click on Search and select the Report Name.   
• If the Report does not yet exist, click Add a New Value.   
• Report Name:  Use the Naming Conventions.  The Report Name should be given the same 

name as the Letter Code.  In this example, the Report Name is S4E. 
• Data Source Type:  Change to XMLDoc Object 
• Data Source ID:  Select the correct Data Source.  In this example, the Data Source is 

WSF_GENERAL_DATA_SOURCE. 
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• The Definition page opens.  Under Report Properties, add: 
• Report Description – use the Long Description from the Comm Key. 
• Report Status – Make Active.  The Report Status must be Active before associating the Report 

Definition with the Letter Code.  If the status is not Active, the process cannot detect the 
Report or the Data Source and Templates associated with it. 

• Report Category ID is a pre-defined security level for reporting.  Select the appropriate level. 
• Object Owner ID – PeopleTools. 
• Template Type – leave as RTF.  Once the Report Definition is saved, the Template Type cannot 

be changed. 
• The Definition page now appears as follows: 
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• Associating a Template:  Click on the Template tab. 
• Verify or add as follows: 

• Template ID – Fills in with the name of the Report plus an underscore and “1” (or another digit 
if there is more than one template.  You can have multiple templates defined under a single 
Report Definition). 

• Default Template – checked 
• Description – Optional, but it’s good practice to use the same name as the Report 
• Language Code – English 
• Channel – either Email or Printer (for “Letter” you would use Printer) – MUST be populated. 
• Effective Date – may be changed to an earlier date.  Helpful tip: choose the day before, in case 

you need to modify your template on the same day after producing ‘live’ communications. 
 

 
 

 
• Status – change to Active.   

1. The Report Definition must have a report status of Active, and each template that you 
want to use must have a status of Active.  The Communication Generation process 
ignores reports and templates with any other status. 

 

 
 

• Once those fields are populated, you can Upload the Word Template – Click on the Upload 
button and browse for and upload the appropriate template file.   
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1. For this example, the Word template file is the one referenced above –
S4E_Pre_Collect_StudentLeft.rtf.   

2. The name of the template file will appear on the bottom of the page.   
3. Notice that the Preview button is now available. 

 

 
 

• The Preview button uses the sample XML data file to generate report output.  When selected, 
it generates readable output. 
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• Report Output Parameters:  Click on the Output tab to verify or define the Output Type. 
 

 
 

 
• Leave all Format Types set at Enabled.  This allows for more flexibility on the Communication 

side setup. 
• For printed letters, set the Default type to PDF or RTF. 
• For email, set the Default type to HTML. 
• Setting your Location to Any will allow you to choose the location on the CommGen Run 

Control. 
• Properties:  Click on the Properties tab.  

• Tools 8.5 and above require pdf-security to be set. 
• The pdf-security setting should already be set properly.  If it is not, this is the method to set it:    

1. From the Property Group dropdown, select pdf-security. 
2. The Default should be set for False.  (This property set to False controls the merge of 

all pages in the output and eliminates blank pages.) 
3. If it is not  set to False, change the Prompt value for the Property pdf-security to False.  

When you save it should appear as follows: 
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• Click Save.   

 
 

15. Create or Adjust the Letter Code   
• In this step you will return to the Standard Letter page in order to link the Report Definition to the 

Letter Code. 
• A letter code must exist for each template that you plan to use.  This is where you add the Report 

Definition you want to use for the Communication Generation process. 
• IMPORTANT NOTE:  The communication generation process depends on the Letter Code to determine 

which Data Source and Template to use.  If the Report Definition with the desired Data Source and 
Template is not associated with a valid Letter Code, it cannot be used to generate an output.   

• Whether you associate the Report Definition with the Letter Code when you first create the Letter 
Code or you go back and adjust the Letter Code to include the Report Definition, you must make the 
association for the Communication Generation process to use it. 

• You can have multiple Report Definitions for each Letter Code. 
• Link the Report Definition to the Letter Code by checking the Define Comm Gen Parameters box on 

the Standard Letter Table CS page as follows. 
• Access the Standard Letter Table CS page.  Navigation  – Main Menu > Campus Community > 

Communications > Set up Communications > Standard Letter Table CS 
• On the Search page, enter/search for the Letter Code (in this example, S4E).   
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• The setup for this Letter Code is demonstrated in the document Part I – Managing Communications, 
Section 4 – Create the Letter Code). 

 
 

• The fields at the top of the page remain the same. 
• The information under Processing Letter Details should appear as follows: 

• Function – Do not change. 
• Applicable to – Do not change. 
• Letter Type – Do not change.  Note:  Leave as Softcopy in order to make available the Define 

Comm Gen Parameters check box.   
1. Reminder: 

a. Hardcopy – does not allow the system to extract data or merge into a soft 
copy template.  It indicates preprinted items, such as brochures or pamphlets. 

b. Softcopy – Allows the system to extract data and merge into a soft copy 
template, which you can then print. 

• Letter Printed Data – Do not change. 
• SQC Name – Remains blank. 
• Joint Communications Allowed – Remains blank in this example. 
• Include Enclosures – Remains blank in this example. 
• Define Comm Gen Parameters – Select to allow the Communication Generation process to 

generate communications with this Letter Code.   
1. Once this check box is selected, the Report Name selection will be limited to reports in 

which the Administrative Function for the Data Source is equal to the Letter Code’s 
Administrative Function, i.e., GEN.   

• When selected, the Template Section group box opens: 

Letter Type must be set to 
Softcopy in order to make 

available the Define Comm 
Gen Parameters checkbox 
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• The Template Selection group box is available only when the Define Comm Gen Parameters check box 
is selected. The fields under Template Selection are related to the Communication Generation process 
only.   

• Click on the Report Name link and select the Report Name from the list.  In this case, it is the newly 
created Report Definition of S4E . 

• Error Message?  If you receive an error message while attempting to the add the Report Definition: 
• First check to be sure that the Report Definition and Template fields are all properly filled.  For 

example, the Channel field must be populated on the Template page.  
• If that is not the problem, then check the underlying query. 

• The Template Selection section of the Standard Letters page now appears as follows: 
 

 

 
• Under the Template Selection area are these fields: 

Report Name 
(Definition) 

Data Source 
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• Report Name – The system displays the name of the Report Definition associated with the 
specified Letter Code and Administrative Function.  

1. To replace a report, click the Report Name link next to it and select the desired report 
on the Look Up Report Name page.  

2. To add a report, add a new row and click Report Name, and select the desired report.   
3. The Report Names listed on the Standard Letters page when you save it are the 

Report Definitions that will be available on the Communication Generation process 
Run Control page for this Letter Code.  

a. Of those reports, only the reports to which the user has security access will be 
available to that user.   

b. Making multiple reports available can be useful if multiple users send different 
templates or personalized templates for the Letter Code. 

• Data Source ID – Displays the Communication Data Source ID that is associated with the 
Report Name that you enter.    

• Template List/Template ID – Lists the Template ID(s) available for merging with the Data 
Source. 

• Template List/Description, Language, Method, and Default – The system displays information 
about the templates available for this communication. 

• View Report Definition – If desired, you can click to open a new browser window displaying 
the Report Definition search page.   

1. In the new browser window, enter the Report Name or other information about the 
definition that you want to view and click Search to access the Report Definition 
component for the report.   

2. View the Report Definition to confirm that it is the definition that you want to make 
available and also to preview the templates.   

3. You can make changes to the Report Definition.   
• Click Save. 

 

16. Create a Population Selection (Pop Select) Query  
• The Population Selection query is used to determine the population to whom you will be sending your 

communication. 
• It is an entirely separate query from the one used previously in CommGen setup (the Data Source 

query). 
• It is used to assign a new communication record to individuals. 
• Bind Records:   

• Each Administrative Function has a Bind Record (or Bind Table) which must be included in any 
Pop Select query for it to be valid. 

• Always start your query with the Bind record. 
• If you always select this record first, and then add additional records, you will then be able to 

see your queries in the Population Selection  PS Query selection field on the Run 3C Engine 
page. 
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• You will ensure that your query is able to populate all the fields in the bind record (such as 
EMPLID, Institution) too, possibly through the use of some prompts depending on what your 
query is selecting. 

• The Bind Record binds the Variable Data to the Query.   
• A Bind Record is a view that contains only data that already exists. 
• This is where you build your conditional logic to attach communications to the correct 

population. 
• The Bind Records are actually SQL views of other records.  In order to use the Bind Record for 

the query it is necessary to have real data in the tables upon which it is based. 
• You must have the key variables as fields in your query.  It should, at a minimum, have the 

same prompts as required by the Admin Function. 
• You must also have the variable data as prompts in the query. 
• Examples of Bind Records include:   

1. SCC_PS_GENP_BND - PopSel Bind for GEN Person 
2. SCC_PS_SFACP_BN - Pop Sel Bind for SFAC – Person 
3. SCC_PS_STRM_BND - PopSel Bind record for STRM 

• To see the names of the Bind Records in Query Manager, search for Record Name begins with 
SCC_PS%BN. 

• You can create the Pop Select Query at any point in the process.  You may even launch the Query 
Manager while on the Run the 3C Engine page.   

• Distinct:  Be sure to return Distinct rows because, if you have duplicate IDs in your output, you will 
assign the communication to that ID as many times as it is on the Query. 

• Open Query Manager:  Reporting Tools > Query > Query Manager 
 

 
Naming Convention for Pop Select Queries 
• Letter “W” 
• Two-character code for the office 
• Two letters “PS” for Pop Select 
• Underscore, then three characters for Admin Function 
• Underscore, then a meaningful name to identify the communication 

 
• In this example (WSF_PS_GEN_PRECOL_GRAD_BALANCE) the query is selecting students with these 

attributes: 
• The associated Admin Function is GEN.  The Bind record is SCC_PS_GENP_BND - PopSel Bind 

for GEN Person 
• From the record WES_STUDENT: 

1. A Program Action equal to COMP.   
2. A Program Reason equal to GRAD. 
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3. Generally, they are recent graduates.  The Class Year is prompted.   
• From the record WSF_NET_ACT_BAL: 

1. An Account Balance greater than the prompted amount.   

 

• As you make changes while creating the query, be sure that the “Distinct” box is checked to prevent 
duplication. 

 

17. Create Event Definition – Event ID - Define 3C Engine Events 
• Once your query is finalized and you know who you are going to be sending your communication to, an 

Event ID (Event Definition or 3C Event) must be created. 
• Purpose:  The Event Definition defines what will automatically be assigned using Speed Keys. 

• It sets up the rules by which the system identifies the sets of communications, checklists, 
and/or comments that will be added or updated by the 3C Engine process. 

• It defines what PeopleSoft will add to a record for an Emplid, i.e. it defines what you want 
done for your student population. 

• The 3C Groups Security defines who has access to this Event Definition. 
• Multiple Communication Speed Keys can be attached, for example, email and letter. 
• Access the Event Definition page.  Navigation  - Campus Community > 3C Engine > Set Up 3C Engine > 

Event Definition 
• Start by adding a new value for the field Event ID.   
• The Event Definition should have the same name as the Letter Code. 
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• Click Add.  The page opens with just two fields populated:   
• Effective Date:  Change to 01/01/1900. 
• Status:  Leave as Active. 

• When completed, the page should be similar to the following: 
 

 
 

• The fields under Event Detail should be updated as follows: 
• Description – in this example, the Communication Speed Keys Description is used 
• Short Description – same as the Comm Key Short Description 
• Function – Enter the Functional area for this 3C Engine Event (i.e., the GEN Function). 
• User Selection – Leave unchecked.  Information regarding this box: 

1. Select this checkbox to enable users to select the communication, comment, and 
checklist to assign to transactions for this 3C Engine Event Definition.  When selected, 
the engine assigns only the communication, comment, and checklist specified by the 
user. 

2. When not selected, the engine assigns all communications, checklists, and comments 
identified in this 3C Engine Event.  

• Under Communications: 
• Comm Key – Enter the Comm Key to specify the communication to assign as part of this 3C 

Engine Event.  Press Tab. 
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• Detail – When you press Tab, Detail becomes a link.  You can click the link to access the Comm 
Key Detail page, where you can view or edit the details of the specified Comm Key.  If any 
elements are missing, return to the appropriate page to update it. 

 

 
 

• Click on the OK or Cancel button to return to the Event Definition page. 
• Click Save. 

 

18. Assign Event 3C Group(s) to the Event Definition (Assign Security)  
• Just as with the Communication 3C Group, the 3C Event Group controls who can access the Event ID. 
• Assign engine event 3C groups to assign security to 3C engine event definitions. 
• Access the Event 3C Groups page.  Navigation – Campus Community > 3C Engine > Set Up 3C Engine > 

Event 3C Groups 
a. Search for and select the desired Event ID (in this example, SFACTSF1). 
b. Under *Group, select the Group or Groups to be associated with the Event ID: 
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c. Click Save. 

 
19. 3C  Engine Run Control – Run 3C Engine 

• Navigation:  Campus Community > Communications > Run 3C Engine 
• Important Note:  The Run 3C Engine process must be run before the Communication Generation 

process. 
• The Run 3C Engine process creates the communication record for the selected cohort. 
• The Run Control lets you define: 

• How you assign the 3C 
• Which event? 
• If PS Query, which one. 
• Allows you to manage duplicates. 

• The PeopleSoft Process Scheduler is used to run the 3C engine process.  Familiarity with using this 
feature is recommended to generate communication assignments systematically. 

• Run 3C Engine with the Population Selection query to assign the communication. 
 

 
 

• To add a new Run Control, start by clicking on the Add a New Value tab.  Enter the Run Control ID (use 
the same name as the Letter Code) – in this example, S4E. 

• The page when opened will resemble this 
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• Populate the fields as follows: 
• Process 3Cs: Check Population Selection.  When you do so, the rest of the page opens. 

 

 
 

• Academic Institution:  WSLYN 
• Administrative Function:  In this example, GEN. 
• Event ID:  The Event Definition (Event ID) recently created (S4E_). 

1. Notice that after these fields have been filed, the Comm Key is displayed under the 
Communication Key section. 

• The page now looks like this: 
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• Detail:  You can click on the Detail link to access the Event Definition page for the specified 
event ID where you can view or update the event definition and determine which 
communications, checklists, and comments the definition includes. 

• The Event Definition Search page opens as shown below.   
• Important Note:  There is a glitch that prevents the display of the proper page.   See that 

there is a notation at the bottom of the page that reads “No matching values were found.”    
 

 
 

• To get around this anomaly, remove from the Description field the words “Wesleyan 
University,” then click the Search Button (i.e., leave the field blank).  When you do so, the 
Event Definition page opens as follows: 
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• To return to the Run 3C Engine page, you can click on the tab for that page.  Unless you are going to 
be working with the Checklist or Comment sections, there is only one more area on this page to fill: 

• Population Selection:   
1. Selection Tool:  Select PS Query. 
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2. Query Name:  In this example, select WSF_PS_GEN_PRECOL_GRAD_BALANCE. 
a. If your query does not appear in the selection box, then there is an issue with 

the query. Check the prompts. 
b.  Note:  If the query has duplicates in the selection, the duplicate check will not 

stop the process.  
• Edit Prompts: When you click on this link, a popup box will appear with prompts from the Pop 

Select Query.  You cannot see the Preview Selection Results without entering the prompts. 
 

 
 
 

• Launch Query Manager:  Click to see the Pop Select Query. 
• Preview Selection Results:  Click to view the recipients of the communication.  

• Manage Duplicate Assignment 
• Purpose:  Prevent duplicate records from being assigned again. 
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• The Check Duplicate Communication and Check Duplicate Checklist boxes are checked by 
default. 

• Specify conditions for preventing duplicate communication and checklist assignment. 
• Considerations: 

1. Use if you know you don’t want a communication to be assigned to an individual. 
a. Build your query so that it excludes people already assigned. 
b. Don’t use check if you know you want to send a specific communication to an 

individual multiple times. 
2. Duplicate management can be used in conjunction with variable data associated with 

the Administrative Function.   
3. If the person (or organization) has already had the communication assigned to them, do 

you want to allow the process to assign another?  
• Click the Explain link beside any item to display a message explaining the options and function 

of that item. 
• Check Duplicate Communication:  Select this check box to require the 3C engine to 

determine if a communication is a duplicate before assigning it. 
1. When this option is selected and no additional conditions are specified, the engine does 

not assign the duplicate if it finds that a communication of that letter code is already 
assigned. 

2. When this check box is not selected, the engine assigns the communication, whether or 
not it is a duplicate. 

• There are detailed descriptions of how to use these selections in PeopleTools at:  
http://docs.oracle.com/cd/E17221_01/cs9pbr2/eng/psbooks/lscc/book.htm?File=lscc/htm/lscc43
.htm%23F1ID_MANAGE_DUP_ASSIGN 

 

20. Communication Generation Run Control 
• Selection Parameters (first page) 
• Navigation:  Campus Community > Communications > Communication Generation 
• Purpose:  The function of the Communication Generation process is to generate letters/emails for 

created communication records not completed.  The process is driven by the Letter Code. 
• Once the 3C Engine process has been run (which creates the communication record for the selected 

cohort), the Comm Gen process can be set up and run. 
• You can’t set up this Run Control unless you’ve assigned the communication to at least one 

user. 
• Use this page to specify general parameters for the Communication Generation process to use for 

extracting data, including recipient IDs for which data is to be extracted, the Letter Code, and the 
Report Definition name.  Also define the language and the method to use for generating the letter or 
email. 

• Start by adding a new Run Control ID.  The Run Control ID should have the same name as the Letter 
Code.  In this example, the name given is S4E. 

• The first page is Selection Parameters, and when completed will resemble this: 
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• ID Selection:  Select the type of IDs to process: 
• All IDs, All Person IDs, One Person ID, All Org IDs, or One Org ID. 
• These are translate values and should not be modified. 
• IDs that are available for processing…  

° Have a communication assigned to them using the specified letter code,  
° Are within the communication date range, and  
° Are not yet completed. 

• For this example, select All Person IDs.   
• Letter Code Selection:  Select the Letter Code from the dropdown box.     

• For this example, select S4E. 
• Note:  Only letter codes set up for the Communication Generation process and that are 

currently assigned to the specified IDs are available (i.e., a valid communication has been 
created and is in the Communication table). 
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• If you do not see the Letter Code:  If you selected All Person IDs for ID Selection, and the 
Letter Code you expect is not in the dropdown list, most likely the Letter Code has not been 
assigned to the specified IDs.  Items to check are: 

° Has the Run 3C Engine process been run? 
° Has the Letter Code been associated with the Report Definition? 
° Are the IDs in the Communications table?   (Check with a query.) 

• Administrative Function:  Displays the Admin Function associated with the Letter code. 
• Template Selection:  Once you have selected the Letter Code, if there is only one related Report, that 

is the Report Name which will appear in this section.   
• If there is more than one report, click on Report Name link to view them all. 
• View Report Definition:   If you wish to look at the Report Definition, click on the View Report 

Definition link. 
• Note:  If you see no Report name or the Report you expect to see does not appear, check the 

following: 
° Is the Report Definition active? 
° Is there a default Template? 
° Is there a Template file uploaded? 
° Is the Template file active? 
° Is the Effective Date for the Template <= today? 
° Do you have the right permissions to see the Report, i.e., do you have a role which has 

access to the Report Category assigned to the Report? 
• Data Source ID and Template List associated with the Report are displayed. 
• Enclosures Assigned (Softcopy):  If the Letter Code includes softcopy enclosures for the IDs, 

the system displays each enclosure code and its relevant information.  Enter the Report name 
to use for each enclosure.  If no softcopy enclosures are included, the system collapses the 
group box. 

• No Matching Template Found:   Select an option to specify what to do if the language and method 
combination to use for an ID is not listed in the Template list for the Report Name selected. 

• Refresh Enclosure List Button:  Click to cause the Enclosures Assigned (Softcopy) section to include all 
available softcopy enclosures including enclosures that were added to the system since the last refresh 
of the process Run Control ID. 

• Communication Language Usage and Communication Method Usage:  Select options in these group 
boxes to identify the Template for the Communication Generation process to use.  In General you 
should not use these boxes and you should leave the default of Specified checked in each. 

 
• Process Parameters (second page) 
• On this page, define the Person Communication Usage, the Communication Processing Dates, and 

Output Settings. 
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• Usage Tables > Person Communication Usage 
1. Fields in this group box are available for input only if the ID Selection field on the 

Selection Parameters page is set to All IDs, All Person IDs, or One Person ID. 
2. If the field is available, you must enter the usage to apply.   
3. Address:  Select appropriate Address from the Address Usage Table look up values.  

Note:  Cannot send to multiple addresses.  Once an address is found, the 
communication goes. 

4. Address Name, Salutation, and Extra Name:  Derived from the Name Usage Table.   
5. Note:  Email communications need an “Email” Address Usage Type 

a. Warning from PeopleBooks regarding Communication Usage: 
i. If the Communication Generation process encounters IDs that are set 

to receive an email but the address usage does not include email 
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types, the process cannot send the email and therefore will not 
generate the communication for those IDs.   

ii. When the method selected on the Selection Parameters page is Email 
or Preferred, then the address usage must include email types or a 
combination of address types and email types; at least one template 
for the main letter code must be for emails. 

• Usage Tables > Joint Salutation Usage 
• Usage Tables > Org Communication Usage 
• Communication Processing Dates > Communication Date Range Selection 

1. Enter the date range of the communication records from which to extract data. 
2. The From Date and To Date ranges are inclusive of the dates that you enter. 
3. IMPORTANT NOTE:   If you set the Communication Date Range Selection to a very 

short period, there will be no output. The process will only print letters which were 
created within the Date Range.  So set it for a long interval to avoid problems. 

• Communication Processing Dates > Update Communication Generation Date With 
1. Default is System Date 

• Communication Processing Dates > Updated Communication Completed Date With 
1. Default is System Date 

• Output Settings 
1. Online Preview: 

a. Select to preview the output online in PeopleSoft Report Manager.  When 
selected, the system sends a sample of all related outputs for Letters and 
Emails to PeopleSoft Report Manager with corresponding links for you to click 
to preview each output.  

b. Previews do not cause communications to be marked completed. 
c. No information is entered in the Person or Organization Communication 

Management components for the communication.   
d. When generating communications for multiple IDs, the online preview 

functionality extracts data for previews of only the first 10 IDs and their 
enclosures and recipients.  

e. Report Manager Output:  Under the Report and Report Description columns 
are displayed the names of the sample communications as PDFs.   

i. The names include the Letter Code, the EmplID, the recipient’s name, 
and a sequence number (1 through 10).    

ii. For example, for the S4E letter, a typical Report name/Report 
Description might be S4E [999999 JOHN JONES  7] – S4E.pdf 
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e. If you click on one of the ten links to the sample communications in Report 

Manager under the Report Column, you can view a PDF version of the output, 
complete with all the variable data that was added to the Template. 

f. Email Address:   If Online Preview is selected, and if on the Selection 
Parameters page, the Communication Method Usage is either Email or 
Preferred, then the Email Address field appears.  Enter an email address that 
you can access to see how the emails will be sent. 
 

 
 

g. Note:  When emails are generated, the main letter code template is used as 
the body text of the email.  To do so, the Communication Generation process 
automatically converts the format of the main letter template to HTML 
format.  If enclosures are assigned, they are sent as attachments and their 
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format is not converted. The process uses their default output type as set in 
the report definition. 

h. When you select Online Preview for an email communication, the system 
sends samples of the generated outputs to the specified email address.  

i. It also includes the output samples in PeopleSoft Report Manager.  
ii. In Report Manager, you can view the outputs for the main letter code 

in HTML format.   
i. Generating Emails and Letters at the Same Time:   

i. Because the Communication Generation process can generate emails 
and letters at the same time (if you use the Communication 
Preferences feature), run the process a second time, but this time do 
not enter an email address for the Online Preview.   

ii. The outputs for the main letter code will not be converted into HTML 
format and you can see exactly what the outputs will look like. 

j. Notes regarding Output Settings: 
i. You cannot save an email to the printer or to a file 

ii. You cannot send communications set to Online Preview to the printer.   
iii. You cannot save communications set to Online Preview to a file. 

2. Send to Printer and Destination Printer: 
a. If the Communication Method Usage is either Letter or Preferred on the 

Selection Parameters page, then the Send to Printer option is available. 
1. Select the check box to send letter communications directly to the 

printer. When selected, the Destination Printer field appears. You 
must enter the path to the printer. 
 

 
 

2. When you are generating letters, you can retrieve the output at 
the specified printer or by clicking the View Generated 
Communication link in each processed ID's Person or Organization 
Communication component (if the letter code is set to save the 
data to the communication record), or both. 

3. Send to File and File Path: 
a. If the communication method usage is either Letter or Preferred on the 

Selection Parameters page, then the Send to File option is available. 
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b. Select the check box to save the generated letter communications as a single 
file. When selected, the File Path field appears. You must specify the file path 
to use. 

 

 
 

c. When the process runs, it sorts and merges all the final letters into one file 
and saves it to the file path that you entered. The filename is 
CommGen_<process instance nbr>.pdf, where <process instance nbr> is the 
unique process instance number assigned by the Communication Generation 
process for that run. 

d. You can use the file to make last-minute changes to the communications or 
send to a third-party vendor such as a mailing company. 

4. Warning from PeopleTools regarding Output Settings:   
a. When generating letters, you must select either Send to File or Send to Printer 

to ensure the ability to retrieve and view the letter outputs.  If you do not 
select either Send to File or Send to Printer, you must manually navigate to 
each processed ID's communication component to retrieve and view the 
output.  However, the output is in the communication record only if the 
assigned letter code is set to save it there. 

b. For emails, the process automatically sends the generated communication to 
each processed ID.  You cannot retrieve and view an email output before 
sending. You can however, select Send to File or Send to Printer to retrieve 
and view the email that was sent. 

5. Missing Critical Data 
a. Under the Missing Critical Data section, choose Produce Communication but 

do not choose Complete Communication.  If an applicant’s record does not 
contain certain critical data (such as name and address), then the letter will 
not be completed. Then it can be checked, the issue addressed, and the letter 
reprinted. 

 
• Email Parameters Tab (third page) 

1. From:  You can enter a real or bogus email address (it just needs to be in email 
format).  If it is not a valid email, your template should include text similar to:  This 
email was sent by an automated system.  Do not reply to this email address. 
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2. Subject:   Enter a subject heading for the email correspondence.  
3. Reply to:   (Optional)  Enter if you want to have a “Reply to” address in the email. 
4. Sender:   (Optional)  Enter if you want to have a “Sender” address in the email. 
5. Bounce to:  (Optional)  If desired, enter email address where invalid deliveries of 

emails will bounce to. 
6. Importance and Sensitivity:  Options that you select in these group boxes appear in 

the email transmission for the recipient to see. 
 

21. Person Communication – Communication Outcome - View Generated 
Communication 

• Access the Communication Management Page.  Navigation:  Campus Community > 
Communications > Person Communications > Communication Management 

• Purpose:  View what was actually sent to recipient. 
• Template is regenerated each time.  File is not saved. 
• Dates that communications were sent are preserved based on effective date. 
• Below are two examples on the Search Page, showing variations in criteria.  If you know the 

EmplId for the individual, you can simply add the ID or you can enter the First and Last Name.  
To narrow it down, you can populate other fields such as the Communication Date to 
encompass a range of dates. 

 

  
 

• Once the search is finished, a list of communications appears at the bottom of the page.  An 
example showing some of the columns in the first few rows is below (the EmplIds and Names 
are blocked out): 
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• In addition to these columns, there are other columns that serve to identify the individuals 
who have had this communication assigned to them. 

• Click on the desired row, and the Person Communication page opens. 
 

 
 

• To understand the details of this page, read over the next section “Assign a Communication to 
an Individual.”   
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• Review the fields to be sure this is the communication you are looking for, and then click on 
the View Generated Communication button. 

• The View Communication page opens: 
 

 
 

• Click on View.  A complete copy of the communication open (RTF Template) opens. 
• Considerations: 

1. You really want to run your 3C Engine and CommGen as close together as possible.  
Otherwise, the population might be out of date. 

2. If you schedule them separately, the 3C Engine might not finish before the CommGen 
starts – i.e. incomplete population. 
 

22. Assign a Communication to an Individual 
• This demonstration of assigning a Communication to an individual illustrates the use of the 

Communication Management pages.  You can access the Communication Management pages as 
described here, or you can access them by clicking the Communication button on pages throughout 
the system.    You will see this references pages spoken of in  the previous demonstration. 

• Open the Communication Management page:  Navigation:  Campus Community > Person 
Communication > Communication Management 
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• Enter the ID of the individual in the first box and click on Add a New Value. 
• When the next page opens, click on the Add button. 

 

 
 
 

• The Communication Management page opens as follows: 
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• Enter or verify the following under Communication Assignment: 
i. Function – Select the appropriate Administrative Function 
ii. Variable Data – see below 
iii. Institution – should be filled in with Wesleyan University 
iv. Comm Key – Based on the Function chosen, you will be given a list of possible Comm 

Keys.  Select the desired Comm Key.  NOTE:  If you do not use a valid communication 
speed key, you must enter the category, context, method, direction, and letter code values 
manually. 

v. Category – Populates based on the Comm Key 
vi. Context  - Populates based on the Comm Key 
vii. Method – Populates based on the Comm Key 
viii. Direction – Populates based on the Comm Key 
ix. Letter Code - Populates based on the Comm Key 
x. Include Enclosures – If the select letter is set up to include enclosures, this box is 

checked.  If not, you can check to add the desired enclosures. 
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xi. Enclosures - This button is available when the Include Enclosures check box is selected. 
Click to access the Communication Enclosure page, where you can review, add, or delete 
enclosures. 

 
(NOTE:  The remaining illustrations are from the PeopleTools section on this topic under “Managing 
Communications.”) 
 
• A filled out Communication Assignment section appears as follows: 
 

 

• If required, click on the yellow Variable Data button.  The Variable Data page appears as follows: 

 
 

i. On this page you can view or enter the required variable data associated with the specified function.   
If you make entries, click OK. 
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ii. Proceed to the Communications Details portion of the page: 

 

i. Communication Date - The default communication date is the system's current date. You can 
override this date.  Enter the date on which the communication should be processed. 

ii. Begin Time and End Time - Enter the times when the communication begins and ends. 
iii. Comments - Enter comments to further identify or describe the communication for this 

individual.  If comments are associated with the communication speed key, the system 
automatically displays them here. You can change these comments or delete them. 

iv. Print Comment – Check to print comments on the communication. 
v. Communication ID - Enter the ID of the staff person who communicated with or is initiating this 

communication with the individual. 
vi. Department - (Optional) Enter the department within your institution that is responsible for 

assigning this communication. 
vii. Create Joint Communications - This check box is available only if the individual to whom you 

are assigning the communication has a joint relationship on the Relationships component and if 
the letter code on the Standard Letters page is set to allow joint communications.  When 
available, select this check box to address the communication jointly to this individual and the 
related individual identified on the Relationships page. 

viii. Checklist Association - The system automatically populates the fields in this group box only 
when the communication is created as part of a checklist. 

• The fields in the Communication Outcome section are automatically completed to indicate the outcome of 
the communication, at which point the fields become uneditable.  If you do not use either of the processes 
and you want to track the communication outcome, you must manually enter the appropriate values in the 
fields. 

i. Communication Generation Date - The system displays the date and time when the process 
generated the communication. 
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ii. Communication Completed - Select the check box to indicate that the communication was 
generated. For example, the communication is complete if the phone call was made or if the 
letter was generated.  If you are using a communication speed key, the system might select this 
check box for you, depending on information associated with that Comm Key. 

iii. Date Activity Completed - Enter the date when completing the communication. The 
Communication Generation process populates this date with the Update Communication 
Completed Date With date from their respective run control page. You can manually override 
this date. 

iv. Unsuccessful Outcome - Select this check box to indicate that the communication was 
unsuccessful. For example, if no one answered the phone or the letter was returned as 
undeliverable.  If you are using a communication speed key, the system might select this check 
box for you, depending on information associated with that Comm Key. 

v. Reason - Available when the Unsuccessful Outcome check box is selected.  Indicates the 
reason that the communication was unsuccessful. 

vi. Language Used and Method Used - Displays the values used by the generating process.  The 
Communication Generation process uses the language and method specified on the 
Communication Generation run control component. 

vii. Process Used - Displays the name of the process used to generate the communication: Letter 
Gen, Comm Gen,or Manual if you manually completed the communication. 

viii. Process Instance - Appears only when the communication for the ID is marked Completed by 
the Communication Generation, or Envelope and Label Generation process. You cannot 
change the number. The process instance number is a reference to the communication data 
used by the process to generate and complete the communication. 

ix. View Generated Communication - This link appears only when a communication is generated 
by the Communication Generation process and the Letter Printed Data field in the Standard 
Letter Table CS component for the letter code used, is set to All or Name/Address Only. 

 

iii. Click Save. 
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